Composer ME 2.6.0 User Guide

Legal notices

Legal notices
Control4 Disclaimer
Control4® makes no representations or warranties with respect to this publication, and specifically disclaims any express or implied
warranties of merchantability or fitness for any particular purpose. Control4 reserves the right to make changes to any and all parts of this
publication at any time, without any obligation to notify any person or entity of such changes.

Trademarks
Control4 and the Control4 logo are registered trademarks of Control4 Corporation. Other product and company names mentioned in this
document may be the trademarks or registered trademarks of their respective owners.

Legal Notice
GNU
GNU GENERAL PUBLIC LICENSE TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION (Section 3.b.)
You may copy and distribute the Program (or a work based on it, under Section 2) in object code or executable form under the terms of
Sections 1 and 2 above provided that you also do one of the following:
Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no more than your cost of physically
performing source distribution, a complete machine-readable copy of the corresponding source code, to be distributed under the terms
of Sections 1 and 2 on a medium customarily used for software interchange.
The complete text for this license is available on the Control4 web site at: http://www.control4.com.
Gracenote
Gracenote®, Gracenote logo and logotype, and the "Powered by Gracenote" logo are either a registered trademark or a trademark of
Gracenote, Inc. in the United States and/or other countries.
Music and DVD recognition technology and related data are provided by Gracenote®.
Gracenote is the industry standard in Music and DVD recognition technology and related content delivery. For more information visit
www.gracenote.com.
MPEG
Fraunhofer IIS and Thomson. MPEG Layer-3 audio coding technology licensed from Fraunhofer IIS and Thomson. Supply of this product
does not convey a license nor imply any right to distribute content created with this product in revenue-generating broadcast systems
(terrestrial, satellite, cable, and /or other distribution channels), streaming applications (via Internet, intranets, and/or other networks),
other content distribution systems (pay-audio or audio-on-demand applications, and the like) or on physical media (compact discs, digital
versatile discs, semiconductor chips, hard drives, memory cards, and the like). An independent license for such use is required. For details,
visit http://mp3licensing.com. Radio Locator is the service provider of AM/FM channel list.
Spread
This product uses software developed by Spread Concepts LLC for use in the Spread toolkit. For more information about Spread see
http://www.spread.org.
All Media Guide
© 2005-2008 All Media Guide, LLC provides music and video recognition technology that provides cover art and related text that
enriches the Control4 user Navigators.

Copyright
© 2014 Control4. All rights reserved. Control4, the Control4 logo, the Control4 iQ logo and the Control4 certified logo are registered
trademarks or trademarks of Control4 Corporation in the United States and/or other countries. All other brands or names may be claimed
as property by their respective owners. Pricing and specifications subject to change without notice.
No part of this publication may be reproduced, photocopied, stored on a retrieval system, or transmitted without the express written
consent of the publisher.

Contact Information
Control4 Corporation
11734 S. Election Road
Salt Lake City, UT 84020 USA
http://www.control4.com
Part Number 200-00171-N
Composer Media Edition User Guide (OS 2.6.0, 9/5/2014 MS)

2

Composer ME 2.6.0 User Guide

Contents

Contents
Legal notices ...............................................................................................2
Contents ....................................................................................................... 3
Introduction ................................................................................................ 5
Purpose ............................................................................................................................................ 5
Related documents and resources........................................................................................ 5
What’s new in this release? ...................................................................................................... 5

Getting started .......................................................................................... 6
Requirements.................................................................................................................................6
Installing Composer ME ............................................................................................................. 7
Starting Composer ME ............................................................................................................... 7
Refreshing the Navigators ........................................................................................................9
Closing Composer ME ................................................................................................................9

Introducing Composer ME ................................................................... 10
Directors dialog ........................................................................................................................... 11
Media view .................................................................................................................................... 12
Stored media .......................................................................................................................................................... 12
Broadcast media ................................................................................................................................................... 13

Menu options ............................................................................................................................... 13
File .............................................................................................................................................................................. 13
Media.......................................................................................................................................................................... 14
Help ............................................................................................................................................................................ 14

3

Composer ME 2.6.0 User Guide

Contents

Setting up media and playlists ........................................................... 15
Setting up media on a controller ......................................................................................... 16
Setting up media on a CD or disc changer ...................................................................... 16
Auto-scan media in Composer ME...................................................................................... 21
Testing the media connection ............................................................................................. 22
Setting up media for television stations .......................................................................... 22
Setting up media for radio stations ................................................................................... 24
Setting up Internet radio ........................................................................................................ 26
Using external storage devices ........................................................................................... 27
Setting up playlists ................................................................................................................... 28
Editing media information ..................................................................................................... 29

Other Composer ME tasks ..................................................................30
Clearing a media list ................................................................................................................. 30
Exporting a media list ............................................................................................................. 30
Importing a media list .............................................................................................................. 31
Updating Composer ME .......................................................................................................... 31

Glossary ...................................................................................................... 32
Index ............................................................................................................ 35

4

Composer ME 2.6.0 User Guide

Introduction

Introduction
Use Composer Media Edition (Composer ME) to set up your media and playlists and
perform other tasks related to your music, movies, and videos.

Purpose
The purpose of this document is to give you instructions, examples, and tips about
how to add and manage the media for your Control4 system. This document applies
to the Control4 Operating System 2.6.0 (OS 2.6.0).

Related documents and resources
Document Title

Location

Control4 System Quick
Start Guide (20000153)

PDF: www.control4.com/customers/resources#documents

Control4 System User
Guide (200-00001)

PDF or Help:
www.control4.com/customers/resources#documents

Control4 Composer
Home Edition Getting
Started
(200-00169)

Help: Composer HE application

Control4 Composer
Home Edition User
Guide (200-00170)

PDF or Help:
www.control4.com/customers/resources#documents

Control4 System
Remote Control SR-250
User Guide
(200-00152)

PDF only: www.control4.com/customers/resources#documents

Instructional videos

customer.control4.com

PDF: www.control4.com/customers/resources#documents

What’s new in this release?
The Composer ME software and hardware updates for OS 2.6.0 are detailed below.

New
•
•
•

New Dry Contact Input Module driver (C4-DCIM4).
Update Manager prompts to replace obsolete hardware before updating.
New Media Services proxy for Wireless Music Bridge, Rhapsody, and TuneIn, and
with support for new media service drivers as they become available.
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•
•
•
•
•
•
•
•

Getting started

Drivers for Wireless Music Bridge, Rhapsody, and TuneIn will automatically update
with the system update, and user account information will be migrated.
MyHome app renamed to Control4 app (MyHome app works with previous
releases).
Search and filtering for project tree.
Sync device selection in System Design view with Connections and Programming
views.
Search added for My Drivers tab.
More information provided when hovering mouse over device in project tree.
System Diagnostics and System Manager logging has been enhanced.
Manage Drivers has been significantly enhanced to enable updating of drivers on
the controller and within the local driver directory.

End-of-life products
•

End of updates for Speaker Points.

Getting started
Use Composer ME to add and scan media, edit media information, and create playlists
in the Control4 system for use with the Control4 Navigators. Using a Windows-based
PC, this program uses a drag-and-drop interface and runs on Control4 OS 2.6.0.
The brain of the Control4 system is the Control4 controller (for example, HC-800).
The controller communicates with Control4 and third-party products to enable home
automation and interaction with Control4-controlled devices.
Notes: (1) The term “controller” referenced in this document refers to any Control4
product that contains the Director component; for example, HC-800 Controller.
Director is the software that controls the system. (2) The new Sony STR-DA2800ES
with Full Control4 Automation and Sony STR-DA5800ES with Full Control4
Automation also use Director.

Requirements
Control4 Composer ME requires that your system is functioning correctly before
attempting to use this software. Talk to your Control4 dealer if this product does not
function as documented; this may indicate that the Control4 system may not be set
up properly.

Computer software and hardware
•
•

•
•
•
•

Microsoft.NET 4 (the Composer install is launched automatically from the
Control4 website).
Microsoft operating systems supported (Windows 8, 7, or Vista). Mac support
when used with a Windows virtual machine such as Parallels or VMWare Fusion
for Mac.
500 MHz or higher processor
256 MB RAM
90 MB available hard disk space
Video card and monitor supporting a resolution of 1024x768 or higher
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•
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Keyboard
Mouse

Home computer network
•
•
•

Wireless access point (WAP) or wireless router that supports 802.11 b/g/n
(optional)
TCP/IP-based (Ethernet) home network. This usually includes a network gateway,
router or switch.
A broadband Internet connection. During initial setup, a broadband Internet
connection is required to update the Control4 system and retrieve the media's
cover art. Also, a broadband Internet connection is required to support remote
access to the system.

Control4 home automation network
•
•
•
•

A Control4 controller (for example, a HC-800 controller).
Control4 Composer Media Edition (Composer ME) software, version 2.6.0.
A valid electronic license to run Composer ME.
Registration at MyControl4 is required. See your dealer or the Control4 System
Quick Start Guide for details.

Installing Composer ME
Follow the steps below to install the Control4 Composer ME software.
Prerequisites
Ensure that you understand the software and network requirements to use this
product. Your dealer or installer can assist you if needed.
To install Composer ME:
1

Start the Composer ME installation and follow the on-screen instructions. You
might be asked for a registration key. If so, check with your dealer or installer for
details.

2

If prompted to update, follow the on-screen instructions to update to the latest
version of Composer ME.

The Composer ME software and device drivers may have been updated when the CD
or web download was created. We recommend, however, that you always choose to
update.

Starting Composer ME
When you start Composer ME, you must connect to Director on your home network.
Prerequisites
Ensure that you have installed Composer ME and registered on MyControl4. You may
want to sign up for and use Rhapsody® also (a subscription-based music service). See
the website for your service to learn how to run the music service in the Control4
system.
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To start Composer ME:
1

From the desktop, double-click the Composer ME icon.

2

At the Composer ME startup screen, click Local System.

3

From the Directors dialog, select the Director’s IP address of the controller you are
setting up.

Tip: If the Director’s IP address does not appear immediately, click Refresh. If it still
does not appear, contact your dealer.
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Click Connect. Composer ME opens to the main Composer ME screen.

Refreshing the Navigators
Use the Control4 Composer ME menu bar to refresh your touch screens, on-screen
Navigators, Control4 apps, and System Remote Control whenever you make changes
to Composer ME.
Prerequisites
•

Ensure that the Navigators are added and identified to the Control4 system. Your
dealer or installer can help you.

To refresh the Navigators:
1

In case your Navigators do not automatically refresh after you've made changes to
Composer ME, from the menu bar, click File, then click Refresh Navigators.

Tip: New media shows up automatically in the Navigators unless your device is
disconnected or has changed locations. In this case, you may need to identify the
device again.
Refer to the Control4 System User Guide to test your Navigator features.

Closing Composer ME
Use the Control4 Composer ME File > Exit or Exit Composer options to close the
application.
Before Composer ME exits, you are prompted to back up your project. It’s always
good practice to do so.
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Introducing Composer ME
The Control4® Composer ME interface lets you:
•
•

Scan media to your controller
Create playlists of MP3, MP4, AAC, FLAC, or WMA files found through scanning.

Prerequisites
Ensure that Composer ME has been installed.
To use Composer ME:
1

Start Composer ME.

2

Connect to the Director on Local Network. (See “Director's Dialog” section
below.)

3

View the Media pane (see below).
Composer ME interface:

When you add or scan media (Media Scanning Options), you can then view and
select the stored/ broadcast media and playlists from the touch screens or onscreen Navigators: TV monitor, touch screens, Control4 apps, and System Remote
Control (in ‘List’ format).
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Directors dialog
After you start the Control4 Composer ME application, the following dialog appears;
you need to use the controller's network address to connect to the Director.
Directors Dialog:

Connecting to a Director on the home network lets you set up your media cover art
and metadata on your controller so it is viewable on the touch screens, Control4 apps,
or on-screen Navigators. Each Director has an associated address.
Director's Dialog buttons:
•
•
•
•
•

Connect—Connect to the Director on your controller.
Cancel—Cancel and close the Director dialog.
Add—Launch a dialog that lets you add the Director’s address of the controller to
which you are trying to connect.
Remove—Lets you remove a Director.
Refresh—Update the Director list to display the recently added Directors.
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Media view
Use the Control4 Composer ME Media view to add or scan your media.
Media view (same view as the main screen after startup):

There are two types of media that can be added or scanned in a Control4 system:
•
•

Stored Media
Broadcast Media

The other two categories are to scan media and manage playlists.
Note: The AMG lookup service has been switched to Gracenote®. The Sony 777 Disc
Changer uses Gracenote, but the Media Controller cannot access album, title, or artist
information from AMG. CDs, however, can be imported and will show up in the Media
database with a date and time stamp.
Other Media Managers: You can use other media managers, for example, iTunes,
Windows Media player, and MediaMonkey to create MP3s, WMAs, or MP4s. You can
still use Composer ME to add files to the Control4 system.

Stored media
Media types supported:
•
•
•

CD—Store CD selections and view the Cover Art, Album, Artist, and Genre type
(such as Rock or Country).
DVD or Disc Changer—Store DVD and CD selections and view the Cover Art,
Title, Info, Results, Media, and Disc List.
Digital Audio Player—Store MP3, WMA, MP4, HDD, AAC, or FLAC music
selections and view the Cover Art, Album, Artist, and Genre type (for example,
Rock or Country) on a digital audio player.
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Network File Storage—Store MP3, WMA, MP4, HDD, AAC, or FLAC music
selections and view the Cover Art, Album, Artist, and Genre type (for example,
Rock or Country) on a hard disk attached to the network or a USB drive.

Broadcast media
Media types supported:
•
•
•
•
•
•

Direct TV—View Direct TV channel options including Station ID, Genre, and Music
Channel.
Dish Network—View Dish Network channel options including Station ID, Genre,
Rating, and Music Channel.
Cable TV—View Cable channel options, including Station ID, Genre, Rating, Music,
and Channel.
UHF/VHF—View UHF channel options including Station ID, Genre, Rating, and
HDTV.
AM/FM—Scan AM and FM stations.
Internet radio—Set up Internet radio stations.

Menu options
Composer ME menu options:
•
•
•

File menu—Connect to the Director on your home network, refresh Navigator
devices with new media information, or exit Composer ME.
Media menu—Create a new playlist, or clear, export, and import media lists. See
“Media Menu” below.
Help menu—View the Composer ME online help and software version.

File
The File menu lets you perform project file management tasks, connect to Director,
start Interviewer, and refresh Composer ME and the Navigators, including touch
screens, Control4 apps (if they are online), and on-screen Navigators. The file
management options relate to the Composer ME project files you back up on your PC
(they have a .c4p extension). Project files always save by default to the 'My
Documents' directory.
When you set up a Control4 system, you create live project configuration information
on the controller that is backed up to a project file on your PC. This lists specific
information about each system, including devices, connections, configuration,
programming information, and media.
•

•

•

Connect to Director—Connects you to the Director residing on the controller.
When you connect, project configuration information from the controller is
displayed on the Composer ME screen.
Disconnect from Director—Disconnects you from the Director. Composer ME
prompts you to back up your project before disconnecting you from the
currently-connected Director. This option is available when connected to the
Director.
Refresh—Refreshes the Composer ME screen with the current information from
Director.
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Refresh Navigators—Refreshes the Navigators with the latest information from
Director. Note: Control4 for PCs and tablets must be updated in that app.
Control4 for iPhone, iPod touch, iPad, and Android devices will update if online.
Exit—Exits Composer. Composer ME prompts you to back up your project prior
to exiting the software and returning to the desktop. Control4 recommends that
you always back up your project before you exit.

Media
From the Media menu, the media either has been scanned or manually added to the
media database. After an item is added to the media database, the cover art and
metadata about the media is viewable and selectable from any of the Navigators.
Tip: Control4 recommends that you use the Export Media List (see below) feature
which lists of all your media saved to the hard drive on your PC.
The following options are available:
•
•
•
•
•
•
•

•
•
•

Clear Media List—Clears the media list associated with the highlighted device
from the media database.
Export Media List—Exports a media list for the selected device from your
controller to your PC.
Import Media List—Imports a media list from your PC to your controller.
Export Playlists—Exports a playlist from your controller to your PC.
Import Playlists—Imports a playlist from your PC to your controller.
Import DVD List from File—Imports a Microsoft Excel list of DVD titles for a disc
changer.
New Playlist—Creates a playlist of MP3, WMA, MP4, AAC, or FLAC files. The
playlist is available from any touch screen or on-screen Navigator. Add albums,
remove songs, re-order songs, etc. Note: If you remove songs from a playlist, it
does not remove them from the media database.
Delete Playlist—Removes a playlist.
Rename Playlist—Renames a playlist.
Tag media files—Used for OS 2.0 conversion of media files so all media players
can see the same tags.

Help
From the Help menu, you can access the online help of this Composer ME User Guide
with Index, Glossary, and Search options, or check the version of your Composer ME
software and Director component.
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Setting up media and playlists
Before you can view and select your media from the Control4 Navigators, the
Control4 system needs to be able to recognize it. So you first need to add and scan
your media to the controller using the Composer ME Media view. See “Auto-scan
media in Composer ME” in this document.

To add and scan songs and albums for playlists, they must be available in MP3, WMA,
MP4, AAC, or FLAC format on a PC, controller, or network share. With the MP3, WMA,
MP4, AAC, or FLAC files you add and scan, you can create playlists and save them
either to the controller’s hard drive or a network storage drive.
Tip: Composer ME requires that your system is functioning correctly before using
your media. For example, if you have a disc changer that does not appear in the left
pane of the Media view, there's no disc changer in the system to add media to it.
Contact your dealer if this is the case.
Prerequisites
Ensure that the appropriate devices have been added and identified to your Control4
system. Your dealer or installer can do this for you.
To add and scan available digital audio player media:
1

Start Composer ME and connect to Director.

2

In the Controller pane, click Add.
Tip: If you get a dialog box that states you cannot add media, make sure your
dealer or installer has identified your controller to the system.

3

Browse to the directory of music files that you want to add or scan.
After the files have been added, the scan automatically starts. In a few moments,
the media is scanned and you will see a list of albums appear. You might see the
on-screen Navigator update during this process also.
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Tip: Another way to add files from a network share to a controller is to go to the
Windows Start menu, and select Run. Type //<controller's IP
Address>/media/audio/music/<Artists>/<Albums> and copy the files there.
4

Refresh your Navigators.

5

The media is now selectable for viewing from the touch screens, Control4 apps,
on-screen Navigators, and System Remote Control.

Setting up media on a controller
Each source device that can provide an audio stream, whether it is a disc changer
plugged into the analog inputs on a Control4 Speaker Point or a controller, can
provide audio to the Digital Audio servers. Each server must be able to connect to the
Digital Audio cloud.
When configuring these connections (your dealer or installer can do this for you),
there is always an open connection to the Digital Audio cloud for each Digital Audio
server or Digital Audio client Consequently, you may see many connections to the
Digital Audio cloud depending on the hardware that is configured in your project.
Prerequisites
Ensure that the appropriate devices have been added and identified to the Control4
system. Your dealer or installer can do this for you.
Procedure
To add and scan available Digital Audio Player media:
1

Start Composer ME and connect to Director.

2

In the Controller pane, click Add.
Tip: If you get a dialog box that states you cannot add media, make sure your
dealer or installer has identified your controller to the system.

3

Browse to the directory of music files that you want to add or scan.
After the files have been added, the scan automatically starts. In a few moments,
the media is scanned and you will see a list of albums appear. You might see the
on-screen Navigator update during this process also.

4

Refresh your Navigators.

5

The media is now selectable for viewing from the touch screens, on-screen
Navigators, and System Remote Control.

Setting up media on a CD or disc changer
When setting up a Control4 disc changer (or CD changer), you can add and scan
media according to the controls available on your disc changer. Adding and scanning
populates the media information to the media database, which lets you view the
media from your touch screens, on-screen Navigators, Control4 apps, and System
Remote Control.
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Notes:
•

•

The AMG c4lookup service from previous releases has been changed to
Gracenote®. The Sony 777 Disc Changer uses Gracenote, but the Media Controller
can no longer access album, title, or artist information from AMG (the previous
lookup service). CDs, however, can be imported and will show up in the media
database with a date and time stamp.
Control4 has not implemented a UI for browsing CDs stored in a disc changer in
OS 2.0 and later. Use an older navigator (prior to OS 2.0) that supports this
functionality if this is important to you.

Other Media Managers: You can use other media managers, for example, iTunes,
Windows Media player, and MediaMonkey to create MP3s, WMAs, or MP4s. You can
still use Composer ME and Composer HE to add files to Control4.
The Sony 777 Disc Changer uses Gracenote, but the Media Controller can no longer
access album, title, or artist information from AMG (the previous lookup service). CDs,
however, can be imported and will show up in the Media database with a date and
time stamp.
In the Media pane, if you select CD or Disc Changer, the following options are
available. In some cases, you select an entry and click a button, or just click one of
these buttons (Search and Scan):
•
•
•
•
•
•

Edit. Edit an entry's metadata (Title, Artist, Director, Genre, etc.).
New DVD. Add new DVDs to the media database.
New CD. Add new CDs to the media database.
Delete. Delete an existing entry.
Scan. Scan the media on your CD or disc changer to the media database
(recommended if available).
Search. Search for media titles on your CD or disc changer in the media database.

The following steps show how to add media to the media database using these
options.
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Prerequisites
Ensure that the CD or disc changer has been added and identified in the Control4
system. Your dealer or installer can do this for you.
To scan media on a CD changer to the media database:
1

Select the CD Changer in the Media pane.

2

In the Disc Changer pane (right pane), click Scan.

3

The scan results appear in the Discs pane. After you refresh your Navigators, you
are ready to play music.

To search media on a Disc Changer to add to the media database:
1

In the Disc Changer pane, click Search. The search dialog appears.

2

Type the DVD name in the blank box. For example, type 'A Beautiful Mind,' and
then click Search. The 'DVD Title' matches appear in the Search Results window.

3

Use the scrollbar if necessary to find the appropriate DVD title.

4

Select the DVD title, drag it directly over the empty line item in the disc changer
list, and then select it.

5

Click Finished.

6

Repeat the previous steps for the DVDs/CDs in the disc changer that you want to
add to the media database.

7

Refresh your Navigators. The media you added is now available to view in the
Navigators.

To add and search using the New DVD or New CD options:
1

Select CD or Disc Changer in the Media pane.

2

Select an 'empty' line item for the New DVD and New CD buttons to appear.

3

Click either New DVD or New CD as appropriate.

4

The New Movie or New Album dialog appears. In the Title box, enter the DVD you
want to play, for example: 'A Beautiful Mind.'

5

Click Search.
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New DVD:

The following results appear:
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Select an entry to get detailed results:

New CD:
Similar results occur as with the New DVD option. Follow the same steps.

6

When the Search dialog appears, use the scrollbar if necessary to find the
appropriate cover art, and highlight it.
You can change the search criteria, and search again if necessary. The possible
matches from the web database appear in the Search Results window (see above).
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7

Click Next. You can choose which information to import, and edit any associated
information before adding the media to the media database (see screen above).

8

Click Finished.

9

Click OK.

10

Refresh your Navigators. The DVD is available to view in the CD or DVD pane and
on the touch screens, Control4 apps, and on-screen Navigators.

Note: If no cover art is found in the file’s metadata, then no cover art is associated
with the music unless the system is registered in 4Sight, and you can go to the online
media lookup (Media view > Edit > Name > Search > Select > Next) to obtain the
cover art for your music. Check with your dealer or installer for details.

Auto-scan media in Composer ME
This section applies to a Sony CX777ES Disc Changer.
The benefits of running a Control4 disc changer with bi-directional communications
(RS-232), for example, Sony CX777ES, is that you can scan your DVDs or CDs stored
in the disc changer to identify, index, and automatically apply cover art and media
information. You can have your dealer or installer configure your Control4 system in
Composer ME to scan media automatically, or you can set a manual scan using the
Scan button. The default is to scan media manually.
Notes:
•

•

•

If you scan a DVD or CD, and the media is not recognized, it will be titled
“unknown.” You can edit the DVD or CD's metadata and manually provide this
information from either Composer ME or the Navigators. If this DVD or CD is then
changed to a different slot, the system will apply this same information.
Because media scanning has been moved to the background, the scanning status
is only available through Director status messages. To do this, you can either
watch the Director status line or re-select the media to view the content that has
been scanned.
Composer ME does not need to be open to scan media. This lets you use other
media managers (iTunes, Windows Media Player, etc.).

Prerequisites
Ensure that the devices you want to scan have been added and identified in the
Control4 system. Your dealer or installer can do this for you.
If you want to schedule regular scans, ensure that your network-attached storage is
set up and is accessible from Composer ME.
To schedule a regular scan of media from a network-attached device, for example:
1

From the Composer ME main screen, select Media Scanning Options. To scan
your media now (and not set up a scheduled scan), click Scan Now and skip the
Scanning Schedule in Step 2.

2

In the Options pane, set the schedule as follows:
•

Scanning Schedule. Select one.
•
Never—Select if you never want to schedule an automatic scan.
•
Every x Days or Weeks (up to 10)—Select the frequency to scan.
•
On the following days—Select Sunday through Saturday.
•
At <time>—Use the up and down arrows to select the time. Highlight AM
or PM and type the value: AM or PM.
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Files To Scan. Select a device and extension.
•
Network File Storage—Select if you have a NAS (network attached
storage) device you want to scan.
•
USB Drive—The manufacturer's USB drive appears here. Select if you
have a USB drive you want to scan.
•
Extensions—Use the up and down arrows to choose the file type to add
or remove. To add a file extension (if it doesn't appear in the list), use the
down arrow to select the extension, select Video or Audio, and then click
Add. Click Remove to remove that file type from the list.
•
Use Online Media Lookup to improve scan results—Check if you don't
want the search to access the Internet for every format lookup, for
example, a specific title or cover art. Tip: Properly tagged files will result
in must faster access.
•
Remove media from the database if the files no longer exist—Check to
remove database information when a media file has been deleted. Be
careful, however, because if for example you disconnect a USB drive with
media on it, the database files will delete them if checked, and you may
not want to delete them if you use the drive again.
•
Update media database if file tags have changed—Check to have the
database updated if the metadata changes.

3

Click Apply.

4

Click Scan Now to start the scan immediately or Stop Scan if you've started the
scan and want to stop it.

Testing the media connection
To test control of media through the Control4 Navigators (System Remote Control,
on-screen Navigator, Control4 apps, or touch screens), use the steps outlined in the
Control4 System User Guide.
Suggested test items:
•
•
•
•
•
•

Play an album
Add an album or track to the Now Playing queue
Play a playlist created in Composer
Create a playlist at a Navigator (for example, one of the touch screens)
Play multiple streams of music (play different music in different rooms)
Play a movie on the television, DVD player, or Blu-ray player

Setting up media for television stations
Use the Control4 Composer ME Media view to set up a broadcast television station
and listings for display in the Navigators.
Prerequisites
Ensure that your television is added and identified in the Control4 system. Your dealer
or installer can help you do that.
To set up media for broadcast television channels:
1

Highlight UHF/VHF or another broadcast media type.

2

Click Search.
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3

When the dialog appears, type your zip code in the box.

4

Click Search, and use the pull-down menu to select Local Broadcast Listings. The
available channels are populated according to the Search Results.

5

Check the boxes to select the desired channels that you want to appear on the
touch screens, Control4 apps, on-screen Navigators, and System Remote Control.

6

Click OK.

The selected stations populate in the UHF/VHF pane. You can edit the information
as needed; add a description, genre, etc.
7

(Optional) To edit a channel, select the channel, and click Edit. The following
dialog appears.
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8

Edit the information and click OK.

9

Refresh your Navigators. The media can now be selected to view in the Navigators.

Setting up media for radio stations
Use the Control4 Composer ME Media view to set up radio station listings to display
on the Navigators.
Prerequisites
•
•

Ensure that your devices are added and identified in the Control4 system. Your
dealer or installer can do that for you.
Ensure that you have a tuner in the system.

To set up media for radio stations:
1

Under Broadcast, select the radio type: AM Radio or FM Radio.

2

Click Search.

3

When the dialog appears, type your ZIP Code in the box.

4

Click Search again. Use the pull-down menu to select AM Broadcast Stations or
FM Broadcast Stations if applicable. The available stations are populated in the
Search Results window.

5

Check the boxes to select the desired stations that you want to appear on the
touch screens, on-screen Navigators, Control4 apps, and System Remote Control
for that radio type.
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Click OK.

The selected stations display in the AM or FM Radio pane.
7

(Optional) To edit a station, select the station, and then click Edit.

8

Edit the information, and then click OK.

9

Refresh your Navigators.

10

Repeat Steps 1-5 for each radio broadcast (AM or FM) you want to set up. Set up
each one separately. The media is now ready to view in the Navigators for
selection.
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Setting up Internet radio
Note: Internet radio supports only MP3, WMA, and MP4 streaming radio stations.
Use the Control4 Composer Media view to add, view and select Internet radio stations
that you can play from touch screens, Control4 apps, or on-screen Navigators.
Prerequisites
•

Ensure that the controller is installed and identified as directed in the controller's
installation guide.
Ensure that the Internet radio stations you add are in MP3, WMA, or MP4 format.
You'll need to create a new form for each station you add.

•

To configure Internet radio:
1

Start Composer and connect to a Director.

2

Click the Media view.

3

From the Media list, click Internet Radio.

4

In the Internet Radio pane, click New.

5

Complete the form:
a

Name—Add the name of the station.

b

Description—Add a description that's meaningful.

c

Channel—Add the URL for the channel. Note: Locate the URL of the MP3,
WMA, or MP4 stream that starts with http://...

d

Genre—Add a genre if appropriate.

e

Check Audio Only for listening.

f

Cover Art—If you'd like, you can copy the radio station art to your list. In a
browser, go to the link and click Images. Click Find Art File to locate an
image, copy it to your clipboard and then click Paste from Clipboard.
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Click OK.

Go to the touch screen, Control4 apps, or on-screen Navigator and select the
Listen > Station. Note: If you have several sources, Internet Radio appears under
Sources.

Using external storage devices
Access digital music from an external storage device attached to your Control4
system. External storage devices include USB flash drives, USB external hard drives,
or a PC’s hard drive on the home network. Set up your music according to the
external storage device and networked file storage as described here.
Note: When you remove the external drive (network, USB, etc.), the music is no
longer available. To access the music again, attach the external storage device, and
then refresh your Navigators.
Prerequisites
External storage devices must have media stored in unprotected MP3, WMA, MP4,
AAC, or FLAC formats.
To attach and scan external storage devices using a USB connection:
1

Power on the external storage device.

2

The documentation for your controller shows you how to attach the external hard
drive to the USB port. Check with your dealer for details or to get a copy.

3

After connecting the external storage device, scan the music on the external
device connected to the controller to make it available on the Control4 system.
Highlight the controller to which the external device is connected.

4

Click the Media view.

5

In the view, select the external storage device.
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Click Scan. When scanning, the media appears as it is located on the controller.

Note: You can add media from the external storage device when connected to the
controller, however, Control4 recommends that you connect your external drive
directly to the PC where you want to copy media, and then attach it to the controller
for scanning.
To access and scan the network-shared storage devices:
1

Check with your dealer to create a shared network drive.
Example: Using Windows to make a local C:/ Drive directory available on the
network, right-click the folder and select Sharing and Security. Click Share this
folder.

2

Configure the username, password, and workgroup (or domain) for the network
file share. This information varies between types; contact your dealer or installer if
you need help with this information.

3

Highlight the Network File Storage object.

4

Click Add or Scan.

Setting up playlists
Use the Control4 Composer ME Media view to set up a playlist to play songs and
albums from your touch screens, Control4 apps, on-screen Navigators, and System
Remote Control.
Prerequisites
Ensure that the appropriate audio devices are added and identified on the Control4
system. Ensure that you have scanned your media in the Digital Audio player. Your
dealer or installer can help you do this.
Playlists are designed exclusively for streaming media in Digital Audio. If you
subscribe to the Rhapsody® music service or another service, then Rhapsody playlists
can be created using a Navigator. Check the website for your music service or the
music service’s Technical Support for details. In OS 2.0 and later, playlists can include
CDs/DVDs, broadcast channels or stations, or Internet stations, but they are in a
separate playlist from those in Rhapsody or your preferred music service.
Note: To set up a Rhapsody subscription, create a Rhapsody account at
http://www.control4.com/rhapsody, and then refer to the information found in the
Control4 System User Guide.
To create a playlist:
1

From the Media menu, select New Playlist.

2

A 'New' playlist appears. You can rename it now, or later you can right-click and
select Rename Playlist to change the name. Example: Change New to Frank’s
Playlist.

3

Drag the list of songs to the playlist.

4

(Optional) Have your dealer or installer add any albums or songs you want to the
playlist. See Control4 System User Guide for details.

5

Create, edit and play songs from your playlists using your touch screens, Control4
apps, or on-screen Navigators.
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To delete albums or songs from the playlist:
1

After you add the albums, select the playlist that contains the songs to delete.

2

Right-click on the songs you don't want in your playlist, and select Delete.
Tip: To remove multiple songs, press Shift, select the songs, and then right-click
Delete.

Editing media information
Use the Control4 Composer ME Media view to edit CD or DVD media information. You
can edit media information also on the touch screens, Control4 apps, or on-screen
Navigators.
Prerequisites
Ensure that the appropriate media devices have been added and identified to the
Control4 system. Your dealer or installer can help you do this.
To edit CD information:
1

In the Media view, double-click the device on which you want to edit a CD, for
example, a CD changer, disc changer, controller, or digital audio.

2

Click the Edit button, or double-click the media under <Media> Title.

3

To edit and enter any changes, click the Album tab (for music), for example. Edit
the information in the boxes under Name, Artist, Label, or Genre.
•
•

Click the Tracks and Notes tabs to view and edit Track Titles and Notes.
Click Find Art File or Remove Art to change the cover art.

4

When you are finished, click OK.

5

Click one of the Search buttons next to the Name to search the database for
similar entries.

6

To select a search result, select the album Title and double-click, or click Next.

7

At the next screen, view and edit the album information, including Name,
Artist/Composer, Label, Genre, Year, Art, and Notes.

8

Make your changes, and click Finished. To return to the previous screens, click
Back.

To edit DVD information:
1

In the Media view, select the disc changer or DVD, and then select a movie.

2

Click the Edit button, or double-click the title under Discs.

3

Click the Movie tab. Edit the Title, Director, Studio, Genre, Run Time, Release date,
and Rating as desired.

4

Click the Cast and Synopsis tab. Click in the Cast and Synopsis boxes to make the
desired changes.

5

Click the Movie tab.

6

Click Search to search the database for other DVDs.

7

Double-click the desired DVD, and edit the information as desired according to the
previous steps.

8

When you are finished, click Finished.
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Other Composer ME tasks
Use the Control4® Composer ME to perform other media-related tasks (see the
sections below).
•
•
•
•

“Clearing a Media List”
“Exporting a Media List”
“Importing a Media List”
“Updating Composer ME”

Clearing a media list
Use the Control4 Composer ME Media menu to clean out information (metadata)
about albums and songs.
Prerequisites
Ensure that media has been added and identified to the Control4 system. Your dealer
or installer can help you do that.
To clear a media list:
1

Select the device on which you want to clear the media information. Example:
Digital Audio.

2

From the Media menu, select Clear Media List. This removes the information
including the title, cover art, and related information from the media database.
Note: This option does not remove the media files.

Exporting a media list
Use the Control4 Composer ME Media menu to export a media list from your media
database to your PC.
Prerequisites
Ensure that the device to export to and the media have been added and identified in
the Control4 system. Your dealer or installer can help you do that.
To export the media list:
1

Select the device on which you want to export the media list. Example: Digital
Audio.

2

From the Media menu, select Export Media List.
This saves a copy of the file that contains all the title art and information from the
media database to your PC.
IMPORTANT! This option moves the media files.
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Importing a media list
Use the Control4 Composer ME Media menu to import a media list from your PC to
your controller’s media database.
Prerequisites
Ensure that the device to export to and the media have been added and identified to
the Control4 system. Your dealer or installer can help you with that.
To import the media list from your PC to the Media Database:
1

Select the device on which you want to import the media list. Example: Digital
Audio.

2

From the Media menu, select Import Media List.
This saves a copy of the file that contains all the title art and information from your
PC to your controller’s media database.
IMPORTANT! This option does not move the media files.

Updating Composer ME
Use Control4 Composer ME to update the software to a new version.
You can update three ways:
•
•
•

Help menu
Windows Start menu
Run the Composer ME install

Prerequisites
Ensure that Composer ME has been installed on your PC.
To update Composer ME:
1

Update according to these options.
•
•
•

2

From the Help menu, select Check for Updates.
From the Windows Start menu, select Start > All Programs > Control4 >
Composer > Update Composer.
Run the installation.

Follow the on-screen instructions to complete the update.
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4Sight: An Internet service that provides a connection
to the home automation system any time and from any
place worldwide.

digital audio player: Provides digital audio streaming
capabilities from a controller with hard disk space for
music and movies.
Director: Each Control4 controller (such as a Home
Controller HC-500) ships with pre-installed Director
software (Linux based) embedded in the device. The
Director communicates with Control4 products and
third-party products to enable home automation and
interaction of individual devices. Director runs the
Control4 devices. Composer Pro is the software used to
connect to and program a system Director that resides
on a controller.

A
AAC: Advanced Audio Coding. A successor to the MP3
format. A standard, lossy compression and encoding
scheme for digital audio. Touts better sound quality.
AV: Audio Video

C

DVD: (Digital Versatile Disc)—A media format for video
and data storage.

CD: (Compact Disc)—An optical disc that stores digital
data. This format is compatible with Control4 products.
Composer: The Control4 software used to design and
define a Control4 home automation system.

E
Ethernet: Uses Ethernet category 5 (CAT5 or CAT5e)
wiring to transfer data. Ethernet uses a star network
topology that allows multiple points to communicate to
a single point. The Speaker Point® devices and touch
screens use Ethernet to communicate to the Control4
controller.

Composer Pro: Composer is used to set up and
configure Control4 devices to communicate with each
other in a home automation system.
connection: Devices that are bound or linked together in
Composer so they can communicate with each other.

F

contact: Contacts are generally used to monitor the
status of something (door, window, water sensor, etc.)
and can be connected through a security panel or
directly using a Control4 controller or Contact/Relay
Extender. Contacts connected to a Control4 controller
or Contact/Relay Extender can be configured either as
NC (normally closed) or NO (normally open).

file format: A format used by applications to store/read
files.
FLAC: Supported by Control4 since software release 1.8,
this is a free, open source, lossless audio codec format
that supports tagging, cover art and fast seeking. Audio
is compressed with no loss in quality.

Control4 system: A home automation system designed
and developed by Control4.

H

controller: The main device that makes home
automation possible. There may be multiple controllers
within a Control4 system. The controller that runs
Director is referred to as the Primary controller.

home network: A network installed in the customer’s
home that provides an Ethernet or wireless connection
so that Control4 devices can communicate with each
other.

D

home automation system: The Control4 system: a line
of home automation products that communicate with
each other over Ethernet, WiFi, or ZigBee for a total
home automation experience.

device: A component that requires a device driver; code
that is used to allow the Control4 system to work with
that device.

L

device driver: Every device in the Control4 system
needs a corresponding device driver to control the
device.

LCD: (Liquid Crystal Display)—A display used with some
Control4 interfaces.
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S

LCD Navigator: An LCD device used to control lighting,
music, videos, etc., on an LCD screen.

scan: An electronic read of media for replay on Control4
devices.

List Navigator: Menu options that are visible on a
System Remote Control.

switch: An extension of a router that adds more
Ethernet ports to support additional devices or clients
on the local network.

M
media database: Media information is stored in the
media database, which will permit users to view the
media from the Navigators.

System Remote Control: A Control4 System Remote
Control is a universal solution that replaces remote
control devices from other manufacturers, and includes
programmable buttons. This System Remote Control
can access on-screen (graphical) Navigators.

metadata: The information that describes the media:
title, cover art, artist, song or movie, genre, etc.
MP3: A music format that makes streaming audio
available.

T
touch screen: A touch screen is a home automation
system Navigator that controls the home’s lighting,
music, videos, and other devices on the home
automation system.

MP4: An audio and video format. Can also store images
and subtitles.

N

U

Navigator: A Control4 Navigator used with the Control4
system to control lights, music, videos, etc. Navigator is
software that the customer interacts with using a
universal remote control, On-Screen Navigator, Control4
apps, or touch screen.

USB: (Universal Serial Bus)—A connector format used
with USB drives that connect to a USB port on Control4
devices.

V

network-attached storage (NAS): A hard drive or
network share drive that can be attached to the
Control4 system and used to retrieve and play music
and movies in the system.

virtual connection: A term used in Composer Pro to
indicate a connection outside the network.
Virtual Director: A connection to a virtual controller
only (a PC is the Director host rather than the
controller). Projects created or edited here are benign
until the saved project is loaded onto a controller.

O
On-Screen Device: Allows you to select the controller
(Media Controller or Home Theater Controller) in the
room that controls the source for the on-screen display.

W

P

WiFi: Uses bi-directional wireless technology to transfer
data. WiFi (wireless fidelity) devices “connect” to each
other by transmitting and receiving signals on a specific
frequency of the radio band using a wireless access
point. This technology uses the star network topology.
WiFi uses high bandwidth 802.11.

playlist: A list of songs compiled in a list. The list can be
compiled by songwriter, album, song type, or any
combination of the above.
programming: A machine-readable artificial language
used to express computations that can be performed by
a device.

WMA: (Windows Media Audio)—Audio data
compression technology developed at Microsoft; an
audio file format that competes with MP3.

project tree: A tree view in Composer where the project
is layered by the larger branches (Home, Office, etc.)
and then the lower branches (floor, rooms, etc.), and
finally to the leaf level (drivers).

R
Remote Director: Connects you to the home network
while working in Composer from a remote location.
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Z

ZigBee Pro: The 1.1 version of ZigBee that provides
improvements in standardization by: allowing more
interoperability with other Control4 devices, support for
home automation profiles, and improving the scalability
of multiple ZigBee access points.

ZigBee: A wireless network that uses bi-directional
wireless mesh network technology to transfer messages
from one device to another. Unlike a star network
topology where devices can only send messages to each
other by sending them first to a single central device
(which then delivers the message to the recipient
device), a mesh network topology allows the devices to
forward messages from one device to another, thereby
extending the effective range of the network. Uses low
bandwidth 802.15.4. 250 devices are allowed per
controller but Control4 recommends 125.
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AAC, 10
Add Director, 11
Add new CD, 18
Add new DVD, 18
Album tab, 29
AM radio, add, 24
AM/FM, 13
AMG lookup, 12
Broadcast media, scan, 12
Broadcast television selection, 22
CD, 12
add new, 17, 20
edit information, 29
CD changer
scan media, 18
set up media, 16
clear media list, 14
Composer
close, 9
refresh Navigators, 9
Composer ME
interface, 9
update, 31
Connect to Director, 11, 13
Contact information, 2
Copyright, 2
Cover art, find, 29
Cover art, not found, 21
Create playlist, 28
Delete media, 17
Delete playlist, 14
Delete songs from playlist, 29
Digital audio, 12
Digital audio player, 28
Direct TV, 13
Directors dialog, 11
Disc changer, 12
Disc Changer pane, 18
disc changer, set up media, 16
Disclaimer, 2
Disconnect from Director, 13
Discs pane, 18
Dish Network, 13
DVD, 12
add new, 17

edit information, 29
DVD, add new, 19
Edit metadata, 17
Exit Composer, 9, 14
Export media list, 14
Export playlists, 14
File extension, add, 22
File menu, 13
File tags, 14
Find cover art, 29
FLAC, 10
FM radio stations, add, 24
GNU, 2
Gracenote, 2
Gracenote lookup service, 12
Hard disk space, 6
HDD, 13
Help menu, 13
Home network requirements, 7
Import DVD list from file, 14
Import media list, 14
Import playlists, 14
Installation, 7
Internet connection, 7
Internet radio, setup, 13
Legal notice, 2
Local broadcast listings, 23
Media Auto-Scan, 21
Media controller limitations, 12
Media database, 12
media database, scanning and
adding to, 16
Media file tags, 14
Media list, clear, 30
Media list, export, 30
Media list, import, 31
Media menu, 13
Media pane, 17
Media scanning, status messages,
21
Media view, 12
Media, remove, 22
Menu options, 13
Movie tab, 29
Movie, add new, 19
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MP3, 10
MPEG, 2
Music, add new, 20
Network file storage, 13
Network requirements, 7
Network share, access, 28
New playlist, 14
Playlist, create new, 28
Playlist, delete songs, 29
Purpose of document, 5
Refresh Composer ME, 9
Refresh Director list, 11
Refresh Navigators, 14
Refresh screen, 13
Related documents, 5
Remove media, 22
Rename playlist, 14
Requirements, 6
Rhapsody, 28
Scan media, 12, 17
Scan now, 22
Scanning
iTunes, 21
Schedule, 21
USB drive, 22
Windows Media Player, 21
Search dialog, 20
Search Results window, 20
Sony disc changer, auto-scan, 21
Start Composer ME, 8
stop scan, 22
Stored media, scan, 12
TCP/IP, 7
Test media, 22
UHF/VHF, 13, 22
UHF/VHF pane, 23
Unprotected format, media
storage devices, 27
USB drive
scan, 22
using, 27
USB port, 27
Video resolution, 6
What's new, 5
WMA, 10

